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PowerTeacher Training

ASTE 2016

Username:  P a s s w o r d :

Chasina Worman
Information Specialist

Scan the QR code with your Smart Phone to
download contact information. (Free QR
readers are available online or through the
app store.)

Training Login Information
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PowerTeacher Quick Reference Card 
 
PowerTeacher is an essential part of the PowerSchool Student Information System. 
PowerTeacher is a web portal to PowerSchool that concentrates all of the features teachers 
need in one spot, including a web-based gradebook. Whether you teach at an elementary 
school or a secondary school, you can use PowerTeacher on a daily basis to help you 
manage your students’ information. 
 
Logging in to PowerTeacher 
You can use PowerTeacher anywhere you have access to the Internet. Its features and 
functions are tailored to duties and responsibilities teachers handle day to day. 
 

Navigating PowerTeacher 
The PowerTeacher Start Page serves as the central point from which you begin your 
PowerTeacher session. It consists of the following areas: the Navigation bar, the ID bar, the 
Main menu, and Current Classes.!

!
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PowerTeacher is an essential part  of the PowerSchool Student Information System.
PowerTeacher is a web portal to PowerSchool that  concentrates all o f  the features teachers
need in one spot, including a web-based gradebook. Whether you teach at  an elementary
school or a secondary school, you can use PowerTeacher on a daily basis to help you
manage your students' information.

Logging in to PowerTeacher
You can use PowerTeacher anywhere you have access to the Internet. I ts  features and
functions are tailored to duties and responsibilities teachers handle day to day.

Navigating PowerTeacher
The PowerTeacher Start Page serves as the central point from which you begin your
PowerTeacher session. I t  consists of the following areas: the Navigation bar, the ID bar, the
Main menu, and Current Classes.

PowerTeacher

Start Page

Deily Bulletin
Staff Directory

Meals
Personalize

Gradebook
Moods

Recommendations

PowerTeacher Quick Reference Card

Current Classes

(A-B) B o l e l y

2(A-B) Biology

3(B) B e g o n i n g  Pottery

4(A-B) B o l o g y

School. Apple Grove High School 2

Term 0 8 - 0 9  Semester 2

(Last Logem 6 /25 /2009  at 1 0 4 7  W r  h t  Scott T

Logout I

Chasina Worman
Information Specialist

Phone: (907) 247-2139 Fax: (907) 225-2356 E-Mail: chasinamorman@kgbsd.org
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Taking Attendance  
It’s easy to take attendance in PowerTeacher. As soon as teachers take attendance, student 
attendance information becomes available to school administrators, parents, and students. 
1. Navigate to Start Page > Chair icon (next to the class for which you want to take 

attendance) 
2. Select the Date  
3. Select the Current attendance code  
4. Click the cell next to a student’s name to assign that code  
5.     Click Submit 
*Note:'Even'if'all'students'are'present,'teachers'should'click'the'Chair'icon'to'open'the'attendance'screen,'and'
then'click'Submit.'This'tells'PowerSchool'that'the'teacher'has'taken'attendance.'

Viewing Student Information  
Access the Student Information Screens by clicking the Backpack for a class, then clicking a 
student’s name. More than a dozen student screens are available through the Select 
Screens menu. The following table provides a brief explanation of the student information 
screens available in PowerTeacher. 
1. Navigate to Start Page > Backpack icon (next to the class you wish to view) 
2. Click a student’s name  

3. Select a screen 
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Student Page Description
Net Access
Summary

Displays a summary of the number of times
that  the parents and student have accessed
PowerSchool v ia the Internet .

Print a Report Use this page to select a school-created
report to print for the student.

Quick Lookup This is the default student page. Displays a
summary of  the student's current  grades and
attendance for  each class. Click the blue links
to access additional information.

Recommendations Displays the teacher's course
recommendations for the student.

Schedule Displays the student's current  class schedule.
Standards Use this page to v iew the student's progress

on specific standards outl ined by  your  state,
district, and school.

Student Photo Displays the student's photo if available.
Submit Log Entry Use this page to create a log entry for

discipline or  other anecdotal informat ion for
the student 's permanent  record.

Teacher Comments If  the gradebook is not  used, displays
comments entered by  the teacher. Comments
can be free form o r  selected f rom a comment
bank. Comments tha t  are published can be
viewed by parents or  students via Parent
Access. Your school decides whether  this page
is active.

Term Grades Displays the student's stored grades for the
current year.

Student Page Description
Cumulative Grade
Information

Displays the student's GPA and class rank
information. Schools decide what information
appears on this page.

Demographics Displays the student's basic demographic
information. It also contains an email link to
the parent or guardian.

Final Grade Entry
(Traditional)

For teachers not using the gradebook, use
this page to enter final grades and comments
for the student. Your school decides whether
this page is active.

Final Grade Entry
(Standards)

Use this page to enter final grades for specific
standards for the student. Your school decides
whether this page is active.

Final Grade Entry
(Citizenship)

Use this page to enter a citizenship grade for
a student. Your school decides whether this
page is active and what code appears.

Meeting Attendance Displays a student's attendance record for the
entire term for  every course in which he or
she is currently enrolled.

3. Select a screen

Az;,
11Taking Attendance

It's easy to take attendance in PowerTeacher. As soon as teachers take attendance, student
attendance information becomes available to school administrators, parents, and students.
1. N a v i g a t e  to Start  Page > Chair icon (next to the class for which you want to take

attendance)
2. S e l e c t  the Date
3. S e l e c t  the Current attendance code
4. C l i c k  the cell next to a student's name to assign that  code
5. C l i c k  Submit
*Note: Even if all students are present, teachers should click the chair icon to open the attendance screen, and
then click Submit. This tells PowerSchool that the teacher has taken attendance.

r.„
111:&Viewing Student Information

Access the Student Information Screens by clicking the Backpack for a class, then clicking a
student's name. More than a dozen student screens are available through the Select
Screens menu. The following table provides a brief explanation of  the student information
screens available in PowerTeacher.
1. Navigate to Start  Page > Backpack icon (next to the class you wish to view)
2. Click a student's name

Chasina Worman
Information Specialist

Phone: (907) 247-2139 Fax: (907) 225-2356 E-Mail: chasinamorman@kgbsd.org
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THE SINGLE-DAY ATTENDANCE SCREEN IS USED TO ENTER ATTENDANCE FOR THE CURRENT DAY 
AND ALSO HAS A PULL-DOWN MENU WHICH GOES BACK A WEEK TO ENTER PAST ATTENDANCE. IN 
ADDITION, THERE IS A FEATURE ALLOWING YOU TO TAKE ATTENDANCE FOR MULTIPLE SECTIONS 
OFFERED DURING THE SAME PERIOD. THIS IS THE ONLY SCREEN IN POWERSCHOOL WHERE YOU 

CAN VIEW AND ACCESS ALL STUDENT ALERTS FROM THE SAME PAGE. 
 From the Start Page in PowerTeacher, click on the chair icon to take attendance. 

 

 Click on the Single Day tab. 

 

 

 

 

 In this view, you can see all alerts for your class at once.  
 There are 3 options for recording attendance. 

1. Select the desired attendance code from the drop-down menu under attendance code. When 
you click in the cell to the right  of  the  student’s  name, the menu will appear with your selected 
attendance code. 

 

 

 

 

2. Type a code in the cell and the drop-down menu will appear with the desired code selected.  

   

 

 
3. Use the arrow key on your keyboard to navigate between students and move the codes 

between students. 

 

 

 

 

Single-Day Attendance and Attendance Comments

THE SINGLE-DAY ATTENDANCE SCREEN IS USED TO ENTER ATTENDANCE FOR THE CURRENT DAY
AND ALSO HAS A PULL-DOWN MENU WHICH GOES BACK A WEEK TO ENTER PAST ATTENDANCE. IN
ADDITION, THERE IS A FEATURE ALLOWING YOU TO TAKE ATTENDANCE FOR MULTIPLE SECTIONS
OFFERED DURING THE SAME PERIOD. THIS IS THE ONLY SCREEN IN POWERSCHOOL WHERE YOU

CAN VIEW AND ACCESS ALL STUDENT ALERTS FROM THE SAME PAGE.

AA From the Start Page in PowerTeacher, click on the chair icon to take attendance.

AA Click on the Single Day tab.

Pagel I

S ive  OTy I   Multi-Day Seating Chart Seating Chart Design 1

-rue 7f31 (Today)  S h o w  Multiple Sectionsl S u E j m i t

A endance Coct D a t e  C l a s s e s

ell In this view, you can see all alerts for your class at once.
ell There are 3 options for recording attendance.

1. Select the desired attendance code from the drop-down menu under attendance code. When
you click in the cell to the right of the student's name, the menu will appear with your selected
attendance code.
Attendance: Tuesday, July 31, 2012

U (Abstnt iUnexcused)

1Preseitl
' T (Tardy.'

L (Late-Excused Tatdy
Fl (Not Dressed Outt
Z (Present)
PC (Foote Centee)

ta.0

2. Type  a code in the cell and the drop-down menu will appear with the desired code selected.

Attendance: Tuesday, July 31, 2012

1(11) (Aol,enttlinextulod) inat i  ..,,,,a
k

3. U s e  the arrow key on your keyboard to navigate between students and move the codes
between students.

Students A l e r t s  A t t e n d a n c e ;  Tuesday, July 31, 2012

Jones, Cul l

Jones, Caroline

Jones, Clare

ciP
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 To take attendance for an earlier date, click on the pull-down menu to go back as far as 1 week. For a 
longer date range, use the Multi-Day Attendance feature. 

 If you teach more than one section during a single period, you can take attendance for both sections at 
the same time. Click on Show Multiple Sections to open this feature. 

 

 You can add a comment to the day’s  attendance  for  an  individual  student. These comments will be 
viewable on your Multi-Day Attendance screen as well as by admin PowerSchool users.  

 

1. Click on the comment icon to the right of the attendance menu. 

 

 

 

 

2. Type your comment in the Edit Comments window and click OK. 

 

 

 

 

 

 

 

 

 

3. The comment icon will turn blue indicating that there is an attendance comment. 

 

 

4. In order to remove a comment, click on the blue icon to bring up the Edit Comment window. 
Delete the text and click OK. 

 

 

Page2 I

2.

Single-Day Attendance and Attendance Comments

a  To  take attendance for an earlier date, click on the pull-down menu to go back as far as 1 week. For a
longer date range, use the Multi-Day Attendance feature.
If you teach more than one section during a single period, you can take attendance for both sections at
the same time. Click on Show Multiple Sections to open this feature. C l a s s e s

1. Cl ick on the comment icon to the right of the attendance menu.

Show Multiple Sections

You can add a comment to the day's attendance for an individual student. These comments will be
viewable on your Multi-Day Attendance screen as well as by admin PowerSchool users.

Jones, Alexandra ( 5 - ( A b i : e - n - 1 / - 1 1 n - e — x c u s — e d  •

Students M o r t  s A t t e n d a n c e ;  W e i d n e r A u l

It
Jones ,  k i t v e y

Jones, B7lana L J
Type your comment in the Edit Comments window and click OK.

Edit Comments

Approximately 1932 characters iett

3. T h e  comment icon will turn blue indicating that there is an attendance comment.

Jones. Alexandra

4. I n  order to remove a comment, click on the blue icon to bring up the Edit Comment window.
Delete the text and click OK.

http://www.cherrycreekschools.org/Schools/CherryCreek/PowerSchool/PowerTeacher%20Instructions/Documents/2.5/AttendanceMultiDay.pdf
http://www.cherrycreekschools.org/Schools/CherryCreek/PowerSchool/PowerTeacher%20Instructions/Documents/2.5/AttendanceMultiDay.pdf
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YOU CAN NOW SELECT A DATE RANGE FOR VIEWING AND ENTERING ATTENDANCE. YOU CAN ALSO 
ENTER ATTENDANCE ON ONE SCREEN FOR CLASSES THAT MEET DURING THE SAME PERIOD 

 From the Start Page in PowerTeacher, click on the chair icon to take attendance. 

 

 Click on the Multi-Day tab. 

 

 Click on Edit to select the desired date range. The default is 21 days, but you can 
change that to anything shorter than a 5-week period.  
 

 

 

 

 

 You can select a date range by typing in the dates, selecting from the calendar or 
choosing a reporting term. A warning message will appear if the requested range is too 
long. 

   

 

 

 

 

 

 

YOU CAN NOW SELECT A DATE RANGE FOR VIEWING AND ENTERING ATTENDANCE. YOU CAN ALSO
ENTER ATTENDANCE ON ONE SCREEN FOR CLASSES THAT MEET DURING THE SAME PERIOD

a  From the Start Page in PowerTeacher, click on the chair icon to take attendance.

il.11 Click on the Multi-Day tab.

Record M (1 i t t e n d a n c e :  1 *English 9 Honors - 3(M-Fri)22

Single Day Mulb -Day  S e a t i n g  Dian !  Seating Chart DesJg—r-il
lit

Attendance Co a t e  Range

f 4Present) , ' 2 3 1 2 0 1 2  - 08/012012

Ciresent)

' —
Update Date Range

Attendance Code D a t e  Range

Pagel I

07/2312012 - •8/31/201

Total

Students (26) A  T

Multi-Day Attendance

7/23 - L i m

M T  W

Select Dates to Display

et Range F r o m  07/23 /2012 7 . k ,  :mv4dcorrrY)

To 08/31/2012 t l y i n o / r e r o

0  Repectirpg Term This Month

From 08/01/2012

To 08/3112012

Cancel E M I

Edit

Edit

tasses

Classes

Show Muftiple Sections

Reporting TOM
'Aii

From I Ft
Si

To F2
• 52

Comments

Display

From 07/21/2012

St

Comments

Display

di  Click on Edit to select the desired date range. The default is 21 days, but you can
change that to anything shorter than a 5-week period.

SubmitS h

7/30 - 813 6 / 6  - 8/10
F T W H F M T W H F  M

11.11 You can select a date range by typing in the dates, selecting from the calendar or
choosing a reporting term. A warning message will appear if the requested range is too
long.

This Week

Update Date Range

IN The large dam range entered may cause display slowdowns. Select
a shorter range if this occurs.

loci Dates to Display
r  R a n g e

Nekt Week
Last Week
Thts Mon th
Last Month

VistiOrtstsWe'S

To  : ) R 1 1 1  2 0 1 ?  ! M t a t i O N T Y T S

Update

Submit
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 If you teach more than one class during the same period, click on Multiple Sections to 
take attendance for both sections at the same time.  

 

 The Multi-Day view will show the total absences and tardies for the selected date range. 
The current day will be highlighted in green.  

 You can type the attendance code or double click to bring up a drop-down menu to 
select the code. 

 

 

 

 

 

 

 

 

 

 Attendance can also be entered using the attendance-code menu on the left and then 
clicking in the cell where you would like to enter the attendance. 

 

 

 

 

 

 You can also choose to view your attendance comments by clicking on Display under 
Comments. If you would like to return to the original view, click on Hide. 

 

 

 

 The comment symbol will appear in blue next to the attendance code. Click on the 
symbol to see the comment.   

 

Multi-Day Attendance

11.1 if you teach more than one class during the same period, click on Multiple Sections to
take attendance for both sections at the same time. Classes

Show Multiple Sections

The Multi-Day view will show the total absences and tardies for the selected date range.
The current day will be highlighted in green.

il.41 You can type the attendance code or double click to bring up a drop-down menu to
select the code.

Page2 I

Single Day] Multi-Day [seating Chart 1 Seating Chart Design
Attendance Code D a t e  Range

(•(Present) t - C i  0772312012 - 08103/2012

Students (26)

Jones, Alexandre 2
Jones, Aubrey
Jones, Brian@
Jones, Cary
Jones, Elizabeth

c —1'•

Attendance Code

U (Absent/ excused)
L (Late-(xcused Tardy)
H (Not Dressed Out)
Z (Present)
FC (Foote Centee)

Commeeltts

Display

Tow. 7 / 2 3  7f27 7 1 3 0  8/3
A T M  T  W H  F  M  T W H  F

M I M - T  1 1 1 1 M —(Present)

Comments

Hick

Edit

Classes

Show Multiple Sections

1 T • ( T a r d  )

Disola)

FC

Cortime

(AbsentiUmexcused
(Late-Excused Tardy;
(Not Dressed Out)
(Resent)
(Foote Center)

I J  Attendance can also be entered using the attendance-code menu on the left and then
clicking in the cell where you would like to enter the attendance.

lid You can also choose to view your attendance comments by clicking on Display under
Comments. If you would like to return to the original view, click on Hide.

The comment symbol will appear in blue next to the attendance code. Click on the
symbol to see the comment.
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YOU CAN USE THE SEATING CHART MODE IN POWERTEACHER TO TAKE ATTENDANCE OR RANDOMLY 
SELECT STUDENTS. 

 From the Start Page in PowerTeacher, click on the chair icon to take attendance and then 
click on the Seating Chart tab.  

 

 From the gradebook, click on the chair icon in the upper-right corner of the screen and then 
select Seating Chart from the Attendance Options window.  

 
 The first time you open Seating Chart view, you will be prompted to Prepolpulate the layout. 
You can take attendance whether you click OK or Cancel. You can design your own seating-
chart layout if you like. 

 

 The date will default to the current date, but you can select a different date from the drop-down 
menu. 

 

 

YOU CAN USE THE SEATING CHART MODE IN POWERTEACHER TO TAKE ATTENDANCE OR RANDOMLY
SELECT STUDENTS.

I J  From the Start Page in PowerTeacher, click on the chair icon to take attendance and then
click on the Seating Chart tab.

1 Single Day"Mult i -Day Sea l i ng  Chart Seal ing Chan Design

Ll ten .2nce  C e
(Present)

Date
4 4  (  Fri fir 3 (Today)

Random Student Selector
2. Select

l a  From the gradebook, click on the chair icon in the upper-right corner of the screen and then
select Seating Chart from the Attendance Options window.

l i p  a g e

Seating Chart: 1

Attendance Options
ha,,qate to Jttendance st&ews

Click a Imk to open the N Elected attendance view

unk D e s c r i p t i o n  S h o r t c u t
Sinole Day T a k e  attendance for a selected day C u l + S h i f t e A

Seating Chart Attendance

I i s H o n o r s  3(M-Fri)

i•D T a k e  and view attendance for a selected date range or CtrisShift•G
eo-otting term

Seatinct Chart t a k e  anendance on your class seating chart c t r i + S h i l t * S
4e;'

Start Page j  .ekrw attendance status and access other featuret. C i l l + S h i l t • H
chiding the daily bulletin, staff directory. and more.

These options are also available from the toolbar on the Attendance menu.

New Layout I l i *

Submit

Edit

ikei The first time you open Seating Chart view, you will be prompted to Prepolpulate the layout.
You can take attendance whether you click OK or Cancel. You can design your own seating-
chart layout if you like.

a  The date will default to the current date, but you can select a different date from the drop-down
menu.



Seating Chart Attendance 
 

2 |  P a g e
 

 You can select an attendance code for an individual student by clicking on the drop-down 
menu  in  the  corner  of  a  student’s  picture  or  you  can  select  a  code  from  the  Attendance Code 
menu  and  click  on  the  student’s  photo.  

  

 After you enter the code, the comment icon will appear allowing you to enter a comment.   

  

 Click on the icon shown above to enter a comment. 

 

 Type your comment in the Edit Comments window and click OK. 

 

 

 

 

 

 

 

 In order to remove a comment, click on the blue icon to bring up the Edit Comment window. Delete the 
text and click OK. 

 Past Comments can be viewed in the Multi-Day attendance page. 

Au b re; H

FC

2 I P a g e

Aubrey Jones

Seating Chart Attendance

i J  You can select an attendance code for an individual student by clicking on the drop-down
menu in the corner of a student's picture or you can select a code from the Attendance Code
menu and click on the student's photo.

i J  After you enter the code, the comment icon will appear allowing you to enter a comment.

Click on the icon shown above to enter a comment.

11-41 Type your comment in the Edit Comments window and click OK.
Edit Comments

Student ad rot attend isass today. Gtramtra, t o o a y

Appmwhately 1932 characters ieft

ea In order to remove a comment, click on the blue icon to bring up the Edit Comment window. Delete the
text and click OK.

a  Past Comments can be viewed in the Multi-Day attendance page.
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Alerts 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Examples: 
 
 
 
 
 
 
 
 
 
 
 

Emergency Medical - Displays emergency contact and immunization information; you can 
also add a medical alert for a student such as allergies, illness using 
this page.  

Other Information - Displays miscellaneous student information such school and course fee 
exemption status and if the student is excluded from class rank. You can 
edit this information; you can also add an “other” student alert using this 
page. Also used for IEP or At-Risk Information. 

Parents/Guardian - Displays the student’s mother’s name and daytime contact information, 
father’s name and daytime contact information, as well as a guardian’s 
name and information, if applicable. If parents or guardians request 
automatic progress reports be sent via email, this information also 
appears. You can edit the parent/guardian information. You can also 
add a parent/guardian alert using this page, informing you that a 
parent may/may not have access to student. 

Log Entries – Displays the log entries that have been entered for the student. From this page, 
you can create new log entries or edit existing ones. Use this page to add a 
discipline alert. 

Birthday – This will alert you that a student’s birthday is coming up. 

Financial Alert – Let you know if the student owes money, balance due. 



PowerTeacher 
Training 
Interface 
Welcome to the 
PowerTeacher 
Gradebook. This 
handout is meant to 
familiarize you with 
the basic 
interactions of 
PowerTeacher and 
provide you a 
functional reference 
to access what you 
need most.  

Tip:	Always	check	that	

you	are	in	the	correct	
Year	and	Reporting	term.	

Log in for training at:  

https://xte.powerschool.com/teachers

Locking the Gradebook: Access it 
in the Menu Bar under File, or by 
typing Ctrl+L

OLD POWERTEACHER GRADEBOOK
GRADEBOOK	 	 2013

	 KETCHIKAN SCHOOL DISTRICT

Key-Stroke Short Cuts for 
Assignments

https://xte.powerschool.com/teachers
https://xte.powerschool.com/teachers


Copying Assignments 
 
THE NEW POWERTEACHER GRADEBOOK DOES NOT HAVE AN AUTOMATIC WAY TO LINK CLASSES OR 
COPY ASSIGNMENTS. YOU CAN CHOOSE TO COPY SINGLE OR MULTIPLE ASSIGNMENTS AT ONE TIME.  
 

x Select Assignment from the Assignments page or the Scoresheet. 
  

 
 
 
 

 
x Copy assignment. 

Right Click (PC) or Control Click (Mac) on Assignment and select Copy Assignments 
from the drop-down menu or select Copy Assignment from the Tools menu. 

 

 
 

x Select assignment(s) to be copied by putting a check in the box to the left of the 
assignment name. When you have finished with your selection(s), click on Next. 

 

 
 
 
 



Copying Assignments 
 

x Select the class(es) to which you would like to copy the assignment and the date due and 
click OK when you are done. 

 

 
 
 
 
 
IMPORTANT: THE ASSIGNMENT DATE MUST BE WITHIN THE DATES SET FOR THE SEMESTER OR THE 

SCORES FOR THE ASSIGNMENT WILL NOT CALCULATE INTO THE FINAL GRADES. 
 

x To check the start and end dates for the semester, go to the Grade Setup screen. 
 
 

 
 
 
 
 
 
 
 
 
 
 

Assignment date may 
be kept the same as 
original assignment 
or you may use the 
current date or a 
different date may be 
chosen. 

Click OK to copy. 







Duplicating Assignments in PowerTeache Pro

PowerTeacher Pro Duplicating Assignments
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Fill Scores 
 
The Fill Scores function can be used to add a group of scores at one time to a single 
assignment. The scores can be added to all students in the class or only to students who 
do not already have scores. It can also be used to mass fill final semester grades for a 
group of students 
 
Click on Scoresheet       Select Assignments Mode 
 
 
 
 
 
 

To Use the Fill Scores function you can: 
 
 

 
 
 

OR 
 

 
 
 
 

The Scores tab will allow you to: 
 
 
 
 
 
 

Right click 
(PC) or 
Control 
Click (Mac) 
on the first 
score cell 
under the 
assignment 
name. 
 

Go to the 
Tools menu 
and click on 
Fill Scores. 
 

Replace scores for 
all students in the 
class or for those 
with unrecorded 
scores only. 

Add score 
abbreviations. 

Add scores 

Type score 
comments 



The Comments tab will allow you to: 
 

 
 

Add comments for all students in 
the class or for those with 
unrecorded scores only. 
 

Add one or more school 
comments or comments 
from your My Comments 
Bank. 

Click here 
to add 
comments
. 

Separate 
multiple 
comments by 
line breaks or 
spaces 

Type here to add personalized 
teacher comments not in the My 
Comment bank. 



Go to the Scoresheet

Choose an assienment. Click into the blank score box across
from the students name.
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How to Customize Class and Section Names in PowerTeacher 

1. Did you know that you can customize your section name into a name that is more descriptive for you and 

parents to see?  It’s easy.   Here’s how.   First, log-in to PowerTeacher.  

 

2. From the TOOLS menu at the top of the screen, select PREFERENCES.   

 
 

 

3. When the menu opens, click on the SECTION tab at the top.   In the SECTION tab menu, click on the radio button 

beside the words “Custom Display Name”.  Then click OK. 

 
 

h""ps://school.kgbsd.org/teachers	
  Launch	
  your	
  PowerTeacher	
  Gradebook.	
  

https://wilkescountyschools.powerschool.com/teachers/pw.html


 

4. In the CLASSES pane, select the class you want to rename.    Then click on the CLASS CONTENT tab across the top 

of the screen.  Make sure the blue CLASS INFO is selected right below the CLASS CONTENT tab. 

 

  
  

 

5. To change the name of the section, you can enter the new name in the blank space beside CUSTOM DISPLAY 

NAME.   Click SAVE in the bottom right hand corner. 

 

 
 

 



 

6. Check back in the CLASSES pane to make sure your custom name is displayed.    If it isn’t, you should repeat step 

#3 from above.  You can continue to rename other classes/sections by selecting them in the CLASSES pane and 

changing their name in the CUSTOM DISPLAY NAME field.  Then click save! 

It’s that easy.  Now every time you access your PowerTeacher gradebook – whether from your browser or the 

app – you’ll see the custom name you chose.  The good news is that parents and students will see it too! 

 
 

7. NOTE:  If you are a special area teacher having trouble interpreting the section name with a grade and/or 

 

teacher,	
  you	
  might	
  fifind	
  it	
  worthwhile	
  to	
  ask	
  your	
  offiffiffice	
  admin	
  assistant	
  what	
  codes	
  were	
  used	
  to	
  set	
  up	
  the	
  sec88ons.	
  	
  
Most	
  school	
  offiffiffices	
  have	
  a	
  system	
  of	
  coding	
  special	
  class	
  sec55ons.	
  	
  



PowerTeacher Quick Entry Tips 

Scoresheet Keyboard Shortcuts 

Task Shortcut (Windows) Shortcut (Mac) 

Assignments: Assign 100% of points 

possible 

Do one of the following: 

• Enter an equal sign (=) and press ENTER 

• Open the Score Inspector and enter an equal sign (=) in the Score 

field 

Collected: Mark or clear a student’s 

assignment as collected 

Do one of the following: 

• Enter Col in the score field (repeat to remove) 

• Enter period (.) in the score field (repeat to remove) 

• Right-click in the score field and select Collected (repeat to 

remove) 

• Open the Score Inspector and select the Collected checkbox 

(deselect the checkbox to remove) 

• Use Fill Scores command to apply to multiple students 

Comments: Add a comment to a 

student’s assignment score 

Do one of the following, and enter comments in the Comment field: 

• Press and hold CTRL+SHIFT+I 

• Right-click on a score field and select Show Score Inspector 

• Use Fill Scores command to apply to multiple students 

Comments: Add a comment to a 

student’s final grade 

Do one of the following and enter comments in the Comment field: 

• Double-click on a student’s final grade 

• Press and hold CTRL+SHIFT+I 

• Right-click on a final grade and select Show Score Inspector 

• Use Fill Scores command to apply to multiple students 

Exempt: Mark a student’s 

assignment as exempt  

Do one of the following: 

• Enter Ex in the score field 

• Right-click in the score field and select Exempt 

• Open the Score Inspector and select the Exempt checkbox 

• Use Fill Scores command to apply to multiple students  

Fill Scores: Assign a score, comment, 

and/or flag (late, collected, missing, 

exempt) to multiple students for an 

assignment 

Do one of the following: 

• Right-click in a score field and select Fill Scores 

• Select Fill Scores from the Tools menu  

Late: Mark or clear a student’s 

assignment as late  

Do one of the following: 

• Enter Lt in the score field (repeat to remove) 

• Enter asterisk (*) in the score field (repeat to remove) 

• Right-click in the score field and select Late (repeat to remove) 

• Open the Score Inspector and select the Late checkbox (deselect 

the checkbox to remove) 

• Use Fill Scores command to apply to multiple students 

simultaneously 

Scoresheet Keyboard Shortcuts continued on next page 



 

Scoresheet Keyboard Shortcuts continued 

Task Shortcut (Windows) Shortcut (Mac) 

Missing/Not Handed In: Mark or clear 

a student's assignment as missing 

Do one of the following: 

• Enter Mi in the score field (repeat to remove) 

• Enter forward slash (/) in the score field (repeat to remove) 

• Right-click in the score field and select Missing (repeat to remove) 

• Open the Score Inspector and select the Missing checkbox 

(deselect the checkbox to remove) 

• Use Fill Scores command to apply to multiple students 

simultaneously 

Override a Final Grade Do one of the following and select the Manual Override checkbox: 

• Double-click in a Final Grade field 

• Right-click in a Final Grade field and select Score Inspector 

• Press and hold CTRL+SHIFT+I 

Zoom In Do one of the following: 

• Click on a final grade field or assignment header and press and hold 

CTRL+SHIFT+= 

• Select Increase on the View menu 

Zoom Out Do one of the following: 

• Click on a final grade field or assignment header and press and hold 

CTRL+SHIFT+- 

• Select Decrease on the View menu 

Score Inspector Keyboard Shortcuts 

Task Shortcut (Windows) Shortcut (Mac) 

Navigate to the next assignment Press and hold CTRL+ALT+RIGHT 

ARROW 

Press and hold 

CTRL+OPTION+RIGHT ARROW 

Navigate to the next student Press and hold CTRL+ALT+DOWN 

ARROW 

Press and hold 

CTRL+OPTION+DOWN ARROW 

Navigate to the previous assignment Press and hold CTRL+ALT+LEFT 

ARROW 

Press and hold CTRL+OPTION+LEFT 

ARROW 

Navigate to the previous student Press and hold CTRL+ALT+UP 

ARROW 

Press and hold CTRL+OPTION+UP 

ARROW 

Open Score Inspector Do one of the following: 

• Right-click in a score field and select Score Inspector 

• Press and hold CTRL+SHIFT+I 

• Select Score Inspector from the Tools menu 



 

Main Menu Keyboard Shortcuts 

Task Shortcut (Windows) Shortcut (Mac) 

Copy Press and hold CTRL+C Press and hold COMMAND+C 

Cut Press and hold CTRL+X Press and hold COMMAND+X 

Hide other application windows  Press and hold ALT+TAB Press and hold 

OPTION+COMMAND+H 

Hide PowerTeacher Gradebook 

window 

Press and hold ALT+TAB Press and hold COMMAND+H 

Open Assignments window Press and hold CTRL+SHIFT+2 

Open Categories window Press and hold CTRL+SHIFT+C 

Open Class Info window Press and hold CTRL+SHIFT+5 

Open Grade Scales window Press and hold CTRL+SHIFT+G 

Open Grade Setup window Press and hold CTRL+SHIFT+4 

Open Gradebook online help Press F1 Press and hold COMMAND+? 

Open New Gradebook window Press and hold CTRL+N Press and hold COMMAND+N 

Open Reports window  Press and hold CTRL+SHIFT+6 

Open Score Inspector Do one of the following: 

• Right-click in a score field and select Score Inspector 

• Press and hold CTRL+SHIFT+I 

Open Scoresheet window Press and hold CTRL+SHIFT+1 

Open Students window Press and hold CTRL+SHIFT+3 

Open the Preferences window  Press and hold CTRL+, Press and hold COMMAND+, 

Paste Press and hold CTRL+V Press and hold COMMAND+V 

Quit PowerTeacher Gradebook Press and hold ALT+F4 Press and hold COMMAND+Q 

Recalculate Final Scores Press and hold CTRL+SHIFT+R 

Revert (discard unsaved changes) Press and hold CTRL+R Press and hold COMMAND+R 

Save Press and hold CTRL+S Press and hold COMMAND+S 

 



FOR ELECTRONIC SESSION MATERIALS 

PLEASE VISIT 

HTTP://ALASKADIGITALACADEMY.ORG/ASTE 

PLEASE ALSO VISIT OUR SITE TO FILL 

OUT OUR SATISFACTION SURVEY.  

ASTE 
POWERTEACHER

THANK YOU FOR ATTENDING  

http://alaskadigitalacademy.org/aste

